Description
The SDAH01 Evaluation Kit is used to assess the HS3001 High-Performance Relative Humidity and Temperature Sensor. The hardware allows users to perform data logging experiments, and it can communicate through a standard USB interface with the user’s computer using the IDT Demo Software. This software makes it possible to view measurements in real-time, adjust the resolution of the sensor, configure measurement parameters, and download previously logged measurements. The Evaluation Board can be powered directly from the USB port of the user’s computer or from a 1632 coin cell battery to enable fully autonomous (untethered) data logging.

Kit Contents
- SDAH01 Evaluation Board
- 3 HS3001 Sensor Modules
- Sensor Module Extension Cable
- USB Key (flash drive) with the IDT Demo Software
- USB Cable
- Quick Start Guide
- User Manual for the SDAH01 Evaluation Kit

Features
- SDAH01 Evaluation Board operating temperature: -40°C to 85°C
- Relative Humidity Sensor Module with HS3001 sensor sample mounted:
  - RH accuracy: ±1.5%RH
  - Operating temperature: -40 to 105°C
- USB key containing the IDT Demo Software:
  - Data plotter
  - Measurement resolution configuration
  - Data export
- Sensor Module Extension Cable allows extending the HS3001 Sensor Module to different measurement areas
Important Notes

Disclaimer
Integrated Device Technology, Inc. and its affiliated companies (herein referred to as “IDT”) shall not be liable for any damages arising out of defects resulting from

(i) delivered hardware or software
(ii) non-observance of instructions contained in this manual and in any other documentation provided to user, or
(iii) misuse, abuse, use under abnormal conditions, or alteration by anyone other than IDT.

TO THE EXTENT PERMITTED BY LAW, IDT HEREBY EXPRESSLY DISCLAIMS AND USER EXPRESSLY WAIVES ANY AND ALL WARRANTIES, WHETHER EXPRESS, IMPLIED, OR STATUTORY, INCLUDING, WITHOUT LIMITATION, IMPLIED WARRANTIES OF MERCHANTABILITY AND OF FITNESS FOR A PARTICULAR PURPOSE, STATUTORY WARRANTY OF NON-INFRINGEMENT, AND ANY OTHER WARRANTY THAT MAY ARISE BY REASON OF USAGE OF TRADE, CUSTOM, OR COURSE OF DEALING.

Restrictions in Use
IDT’s SDAH01 Evaluation Kit consisting of the SDAH01 Evaluation Board, HS3001 Sensors, cables, documentation, and IDT Demo Software are designed to provide a quick setup for taking RH% and temperature measurements with the HS3001 only. IDT’s SDAH01 Evaluation Kit and IDT Demo Software must not be used for any mission-critical applications, end-customer products, or measurement reference source.

Contents
1. Setup .................................................................................................................................................. 3
   1.1 User Computer Requirements and Setup ....................................................................................... 3
      1.1.1 Computer Requirements ........................................................................................................... 3
      1.1.2 Software Installation and Setup .................................................................................................. 3
   1.2 Kit Hardware Connections ............................................................................................................ 4
2. Usage Guide ......................................................................................................................................... 5
   2.1 Measurement Settings ....................................................................................................................... 5
   2.2 Exporting Data ................................................................................................................................. 6
   2.3 Data Logging Mode (Untethered) ..................................................................................................... 6
   2.4 Data Logging Settings ....................................................................................................................... 7
   2.5 Using the Plotter ............................................................................................................................... 7
   2.6 Valid Settings Ranges ....................................................................................................................... 7
3. Ordering Information ............................................................................................................................ 7
4. Revision History .................................................................................................................................... 8

List of Figures
Figure 1. Initial Display after Installation of the IDT Demo Software ........................................................ 3
Figure 2. Evaluation Kit Connections ........................................................................................................ 4
Figure 3. Measurement Settings .............................................................................................................. 5
Figure 4. Set Resolution ........................................................................................................................... 5
Figure 5. Battery Installation ................................................................................................................... 6
Figure 6. Download Data to IDT Demo Software .................................................................................... 6
1. Setup

1.1 User Computer Requirements and Setup

1.1.1 Computer Requirements
A Windows®-based computer is required for interfacing with the kit and configuring the part. The user must have administrative rights on the computer to install the IDT Demo Software for the kit.

The computer must meet the following minimum systems requirements:
- CPU: Intel or compatible
- RAM: 512 MByte
- Windows® XP / Vista / 7 / 8 / 10
- Ports: One available US port

1.1.2 Software Installation and Setup
Follow these procedures to install the IDT Demo Software:
1. Plug in the USB flash drive to start the setup.
2. If the setup process does not start automatically, double-click on the Setup.exe file.

Figure 1. Initial Display after Installation of the IDT Demo Software
1.2 Kit Hardware Connections

Follow these procedures to set up the kit as shown in Figure 2:

A. Install the software from the USB flash drive as described in section 1.1.2.

B. Connect one of the HS3001 sensor modules facing up, with or without the extension cable attached, into the sensor module connector 1.

C. Connect the USB port 2 of the board to the user’s computer using the supplied USB cable, and ensure that the power switch 3 on the board is in the USB position. The “USB” LED 4 will light.

D. Run the IDT Demo Software package from the Start menu, and click on the “Measure” button 5. The “Measuring” indicator 6 will blink whenever data is being captured.

Figure 2. Evaluation Kit Connections
2. Usage Guide

2.1 Measurement Settings

To change the interval and number of measurements to be made, select Measurement Settings from the Tools menu, enter the desired values, and then click OK, as shown in Figure 3. See section 2.1 for the range of valid settings for these two entry fields.

Figure 3. Measurement Settings

To change the measurement resolution, select Set Resolution from the Tools menu, select the desired resolution, and then click OK, as shown in Figure 4. The resolution setting is stored on the sensor, and it will be the default value applied when measurements are started. Measurement settings can be changed only when no measurements are being taken.

Figure 4. Set Resolution
2.2 Exporting Data

The data displayed in the plotter area can be exported in two different formats.

- To export the measured data points in a Microsoft Excel® compatible comma-separated text file, select Save Data from the File menu. Create a filename for the data, and select the location where the file will be saved.
- To export the plots themselves as a picture file, right-click on the plot area and select Save Image As. Create a file name, select the location, and select the file type for the image.

2.3 Data Logging Mode (Untethered)

Disconnect the kit from the computer. Ensure that a battery is inserted in the battery holder on the back of the board with the positive battery terminal facing away from the board, as shown in Figure 5.

**Figure 5. Battery Installation**

![Battery Installation](image)

The following steps describe how to operate the kit in the data logging mode (see Figure 2).

1. To set the board to the data logging mode, put the power switch in the “Batt” position.
2. To start data logging, hold the “Start/Stop Logging” button for 3 seconds. The “Measuring” indicator will light for 2 seconds and then start blinking on every logged measurement. This can be disabled to extend the battery life by toggling the “L2 Enable” switch.
3. To stop data logging, press the “Start/Stop Logging” button. The “Measuring” indicator blinks 3 times to indicate the end of data logging.
4. To download the logged data to the IDT Demo Software, connect the USB port to the computer using the supplied USB cable, and ensure that the power switch on the board is in the USB position. The “USB” LED will light.
5. In the software, select Data Logging from the Tools menu and click on the Download Data button as shown in Figure 6. The maximum number of measurements that can be stored on the board is 2000.

**Figure 6. Download Data to IDT Demo Software**

![Download Data to IDT Demo Software](image)
2.4  Data Logging Settings
To change the data logging measurement interval, select Data Logging from the Tools menu, and then click on Change Interval. Enter the desired measurement interval, and click OK.

The data logging resolution can be selected in the same fashion as described in section 2.1.

Data logging settings can only be changed when no measurements are being taken.

2.5  Using the Plotter
The plotter displays the measured relative humidity and temperature data simultaneously versus time (see Figure 2).

- Hold the left mouse button, and drag it around an area to zoom onto that area.
- Hold the middle mouse or scroll button, and drag to pan across the plot area.
- To undo a zoom or pan operation, right click on the plot area, and select Un-Zoom (Un-Pan).
- The plot area can always be reset to the default view by right clicking on the plot area and selecting Undo All Zoom/Pan.
- To display the measurement points on the plotted curves, right click on the plot area and select Show Data Points. While moving the application window, measurements points will not be plotted.

2.6  Valid Settings Ranges
Measurement settings can be selected within the following ranges:

- Measurement interval: 0.5 to 3600 s.
- Number of measurements: 1 to unlimited.
- Data logging interval: 1 to 250 s.
- Measurement resolution: 8, 10, 12, 14 bits.

3.  Ordering Information

<table>
<thead>
<tr>
<th>Orderable Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDAH01</td>
<td>SDAH01 Evaluation Kit, including SDAH01 Evaluation Board, HS3001 sensor modules, sensor module extension cable, USB key with IDT Demo Software, USB cable, Quick Start Guide, User Manual for the SDAH01 Evaluation Kit</td>
</tr>
</tbody>
</table>
### 4. Revision History

<table>
<thead>
<tr>
<th>Revision Date</th>
<th>Description of Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>November 16, 2017</td>
<td>Initial release.</td>
</tr>
</tbody>
</table>
Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.

5. Renesas Electronics products are classified according to the following two quality grades: "Standard" and "High Quality". The intended applications for each Renesas Electronics product depends on the product's quality grade, as indicated below.

   - **Standard**: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
   - **High Quality**: Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial terminal systems; safety control equipment; etc.

   Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space systems; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.

6. When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, "General Notes for Handling and Using Semiconductor Devices" in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such specified ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury, injury or damage caused by fire, and/or disaster to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are responsible for evaluating the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

(Note1) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled subsidiaries.

(Note2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.

(Rev.4.0-1 November 2017)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Contact Information
For further information on a product, technology, the most up-to-date version of a document, or your nearest sales office, please visit:
www.IDT.com/go/support

Trademarks
Renesas and the Renesas logo are trademarks of Renesas Electronics Corporation. All trademarks and registered trademarks are the property of their respective owners.

© 2019 Renesas Electronics Corporation. All rights reserved.